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Purpose 

This document highlights the main accessibility guidelines for the university electronic content 

grouped per the below role-based categories: 

• Developers 

• Designers 

• Content Authors 

• Audio and Video Media 

In the appendix, the guidelines are restated by tool/platform to provide a comprehensive 

perspective. There is also a section for different testing tools to ensure that web content is 

accessible to all users, including those with disabilities. 
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Introduction 

Digital accessibility is making sure users with disabilities can interact with your electronic 

content. Web Content Accessibility Guidelines (WCAG) covers a wide range of 

recommendations to make online content: 

▪ Perceivable - content must be perceivable to all users. Keep in mind that users 

perceive content with a variety of senses, output devices, and settings. 

▪ Operable - user interface components, including menus, links, and controls must be 

operable by all users. Keep in mind that users operate such controls using a variety of 

input devices, including mouse, keyboard, stylus, touch screen, speech, and other 

assistive technologies.  

▪ Understandable - content and the user interface must be usable and easy to 

understand. 

▪ Robust - Content must use standard technologies and be coded in a way that will 

increase the likelihood of its being supported across all web-enabled technologies 

including assistive technologies and future technologies. 

There are three levels of compliance with WCAG, at AUB the targeted level is WCAG 2.0. 

Following these guidelines will make content accessible to a wider range of people with 

disabilities, including: 

• Deafness: Inability to acquire info in audio-only format 

• Hard-of-hearing: Difficulty acquiring info with specific frequencies, insufficient volume, or 

background noise 

• Physical impairments: Limited (or no) use of limbs may prevent usage of pointing 

devices 

• Blindness: Inability to acquire info in visual-only format 

• Low-vision: Difficulty acquiring certain visual info (e.g. limited visual fields, color, or 

motion perception) 

• Cognitive/neurological: Difficulty perceiving, processing, and retaining video content 
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Developers Checklist 

HTML Validity Make sure that: 

• Elements have start and end tags 

• Elements do not contain duplicate attributes 

• All elements IDs are unique 

HTML Structure • Identify page language (Html <lang=”en”>) 

• Use only one <h1> heading on every page 

• Make sure that headings (<h1> <h2> etc.) are hierarchically 

ordered 

• For lists, use list tags (<ul>, <ol>, <li>) 

Page Title • Provide a descriptive content title <h1> on every page 

https://www.w3.org/WAI/tutorials/page-structure/headings/ 

Form Labels • Associate a label <label> with every form control to help the 

reader understand the required input <input>  

• Provide a description for groups of related form elements by 

using <fieldset> and <legend> tags 

Tables • For regular table data (one heading, two headings), use the 

proper markup (<table>, <th scope=” row/col”>, <td>, etc.) 

• For a table with irregular headings (a cell that span multiple 

columns and/or rows), use scope attributes colgroup or 

rowgroup 

Images • Use CSS methods or empty <alt> value for decorative and non-

meaningful images 

• Use the <img> tag only to show content images, such as photos 

or illustrations, that are meaningful to the content  

• Ensure that alternative text <alt> for images is added to all 

informational and functional images 

Text • The text should be at least 12 pt. 

Links • Use <button> for elements that perform a within-page function 

• Use links <a> for element that load a new page 

https://www.w3.org/WAI/tutorials/page-structure/headings/
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Check Buttons vs. Links: 

-  http://web-

accessibility.carnegiemuseums.org/content/buttons/ 

- https://www.webaxe.org/proper-use-buttons-links/ 

• Write a helpful link text, for example, “Read more about 

Accessible Landmarks” 

Skip Navigation • Provide skip navigation that allows the user to easily skip to the 

main content of the page with a simple click without the need to 

go through headers, menus, and other repetitive elements on 

every page 

Keyboard 

Navigation 

• Think about keyboard access, especially when developing 

interactive elements, such as menus, mouseover information, 

collapsible accordions, or media players 

• Use tabindex to indicate the sequential focused elements and to 

use the "tab" button is used for navigating 

• Use tabindex="0" to add an element that does not normally 

receive focus, such as <div> or <span>, into the navigation 

order when it is being used for interaction. 

• Use scripting to capture and respond to keyboard events 

Zoomability • Use responsive design to adapt the display to different zoom 

states and viewport sizes 

• When font size is increased by at least 200%, avoid horizontal 

scrolling and prevent any clipping of content 

ARIA • Avoid ARIA elements and use standard HTML controls and 

elements, such as <input>, <select>, and <button> 

• If you use ARIA attributes, ensure they are applied correctly on 

the right elements, as described in the ARIA 1.1 specification  

Errors • Ensure that all error text is marked as such with a heading value 

starting “Error:", or by using of an error symbol 

Dynamic Content • Ensure that core functionality and content is available regardless 

of the technology being used for development. 

• Ensure that text size and line width are set to maximize 

readability and legibility 

http://web-accessibility.carnegiemuseums.org/content/buttons/
http://web-accessibility.carnegiemuseums.org/content/buttons/
https://www.webaxe.org/proper-use-buttons-links/
https://www.w3.org/TR/wai-aria-1.1/
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• If an element creates or shows new custom content, ensure that 

the content directly follows the activating element in the DOM or 

innerHTML (such as a hide/show dropdown).  

 

Designers Checklist 

Page Layout • Provide visible form labels close to their controls 

• Avoid complex page layouts (e.g. Three or more columns) 

• Use whitespace and proximity to make relationships between 

content more apparent 

• Style headings to group content, reduce clutter and make it 

easier to scan and understand. 

Navigation • Provide clear and consistent navigation options (site search or 

a site map and clear, descriptive, and ordered headings) 

Color • When using color to differentiate elements, also provide 

additional identification that does not rely on color perception 

Contrast • Provide designs with text vs. background color contrast 

(including text on images, button, or other elements) of at least 

4.5:1 for normal text and 3:1 for large text 

Form Labels • Ensure that all fields have a descriptive label adjacent to the 

field 

• Avoid having too much space between labels and fields 

Images • For informative and functional images, make sure to include a 

short description conveying the essential information presented 

by the image (e.g. <alt> value in HTML) 

• Make sure to mention if the image is descriptive (e.g. leave 

<alt> value empty in HTML) 

• For text images, the text alternative should contain the same 

words as in the image 

Media • Make sure that all recorded audio and videos should have 

captions 
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• Provide audio described versions for non-speech video 

• Provide transcripts for audio 

• Provide controls for content that starts automatically 

(carousels, image sliders, background sound, and videos) 

Dynamic Content • Ensure that core functionality and content is available 

regardless of the technology being used 

• Make sure that text size and line width are set to maximize 

readability and legibility 

Feedback • Provide feedback for interactions, such as confirming form 

submission, alerting the user when something goes wrong, or 

notifying the user of changes on the page 

• Instructions should be easy to identify 

• Important feedback that requires user action should be 

presented in a prominent style 
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Content Authors Checklist 

Page/Document 

Structure 

• For each web page/document, provide a descriptive title and a 

short summary that describes the purpose 

• Put the unique and most relevant information first 

• Use hierarchically ordered headings to convey meaning and 

structure 

Content Keep content clear and concise: 

• Write in short, clear sentences and paragraphs 

• Avoid using unnecessarily complex words and phrases 

• Consider providing a glossary for terms readers may not know 

• Expand acronyms on first use. For example, Web Content 

Accessibility Guidelines (WCAG) 

• Use list formatting as appropriate 

Text Size • Text size should be at least 12 pt. Fonts should be sans serif 

(With no edges on the sides of the letter) and the color contrast 

at a minimum 4.5:1 

Links • Write a meaningful link text that describes the content of the 

link target 

• Avoid using ambiguous link text, such as ‘click here’ or ‘read 

more’ 

• For document type link, indicate relevant information such as 

document type and size. 

Images • Always use alternative text for informative and functional 

images 

• For decorative images, state in the alternative text that this 

image is used for decoration 

Tables • Indicate column and row headers 

• Provide a concise summary of the purpose of the table 

• Provide descriptive alt text 

• Avoid merging cells together 
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Audio and Video Checklist 

Audio • Use high-quality microphones and recording software 

• Record in room isolated from all external sounds 

• Avoid rooms with hard surfaces such as wood floors and tile 

• Use low background audio (at least 20 decibels lower than the 

speech) when the main audio is a person speaking so people 

with hearing or cognitive disabilities can easily distinguish the 

speaking from the background 

• Avoid sounds that can be distracting or irritating, such as some 

high pitches and repeating patterns 

• Speak clearly and slowly for people to understand the content, 

and for captioners 

• Give people time to process information (pause between 

topics) 

• Avoid or explain jargon, acronyms, and idioms 

• Provide a transcript 

Video • Avoid anything that flashes more than three times in any one 

second period 

• Ensure that the speaker’s face is visible and in good light to 

help understand the language spoken for people who use 

mouth movement 

• For any text, consider the font family (Sans serif), the size (18 

pt.) and contrast (3:1) between the text and background 

• Provide audio description for any visual information while 

recording so that blind people can understand the visual 

content 

• Always include captions 

• Provide a transcript 

• Use accessible media players 
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Accessibility Tools 

Web 

Accessibility 

Testing Tools 

• WAVE 

https://wave.webaim.org/  

This tool uses WCAG 2.1 AA and Section 508 

• Cynthia Says 

http://www.cynthiasays.com/ 

• HERA-FFX 

http://www.sidar.org/recur/aplica/heraffx.php 

• MAUVE 

http://mauve.isti.cnr.it/ 

• Web Accessibility Checker (ASP.NET Visual Studio) 

https://visualstudiogallery.msdn.microsoft.com/3aabefab-1681-

4fea-8f95-6a62e2f0f1ec 

Email 

Accessibility 

• Accessible Email 

http://www.accessible-email.org/ 

• Campaign Monitor (Create accessible email) 

https://www.campaignmonitor.com/ 

Audio and 

Visuals 

• N/A 

Color Contrast • A11Y Color Contrast Accessibility Validator 

https://color.a11y.com/?wc3 

• Button Contrast Checker 

https://www.aditus.io/button-contrast-checker/ 

• Color Contrast Checker 

https://www.oss-usa.com/color-check-ada-image-compliance 

• Color Contrast Determinator 

http://www.visionaustralia.org/digital-access-determinator 

• Contrast checker 

https://addons.mozilla.org/EN-US/firefox/addon/wcag-contrast-

checker/ 

• Contrast Checker (Website) 

https://addons.mozilla.org/EN-US/firefox/addon/wcag-contrast-

checker/ 

https://wave.webaim.org/
http://www.cynthiasays.com/
http://www.sidar.org/recur/aplica/heraffx.php
http://mauve.isti.cnr.it/
https://visualstudiogallery.msdn.microsoft.com/3aabefab-1681-4fea-8f95-6a62e2f0f1ec
https://visualstudiogallery.msdn.microsoft.com/3aabefab-1681-4fea-8f95-6a62e2f0f1ec
http://www.accessible-email.org/
mailto:https://www.campaignmonitor.com/
https://color.a11y.com/?wc3
https://www.aditus.io/button-contrast-checker/
https://www.oss-usa.com/color-check-ada-image-compliance
http://www.visionaustralia.org/digital-access-determinator
https://addons.mozilla.org/EN-US/firefox/addon/wcag-contrast-checker/
https://addons.mozilla.org/EN-US/firefox/addon/wcag-contrast-checker/
https://addons.mozilla.org/EN-US/firefox/addon/wcag-contrast-checker/
https://addons.mozilla.org/EN-US/firefox/addon/wcag-contrast-checker/
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PDF (Portable 

Document 

Format) 

• Acrobat XI Pro 

http://www.adobe.com/products/acrobat/pdf-accessibility-wcag-

508-compliance-standards.html 

• CommonLook Office Professional: 

https://commonlook.com/accessibility-software/office/ 

• PAC: PDF Accessibility Checker 2.0 

http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-

pac.html 

• Tingtun PDF Checker 

http://checkers.eiii.eu/en/pdfcheck/ 

Microsoft Office 

365 

• In Word, Excel, and PowerPoint, select Review > Check 

Accessibility 

• In Outlook, select Options > Check Accessibility 

• In OneNote, select View > Check Accessibility. 

Screen Reader • Windows Narrator (Windows logo key + Ctrl + Enter) 

• Mac Narrator (Settings->Accessibility) 

• NVDA (Windows) 

http://www.nvda-project.org/ 

• ORCA (Linux) 

http://projects.gnome.org/orca/ 

• Spoken Web (Internet Explorer) 

http://www.spoken-web.com/index.cgi?p=download 

• ChromeVox (Google Chrome) 

https://chrome.google.com/webstore/detail/kgejglhpjiefppelpmljglc

jbhoiplfn 

 

 

 

 

 

http://www.adobe.com/products/acrobat/pdf-accessibility-wcag-508-compliance-standards.html
http://www.adobe.com/products/acrobat/pdf-accessibility-wcag-508-compliance-standards.html
https://commonlook.com/accessibility-software/office/
http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac.html
http://www.access-for-all.ch/en/pdf-lab/pdf-accessibility-checker-pac.html
http://checkers.eiii.eu/en/pdfcheck/
http://www.nvda-project.org/
http://projects.gnome.org/orca/
http://www.spoken-web.com/index.cgi?p=download
mailto:https://chrome.google.com/webstore/detail/kgejglhpjiefppelpmljglcjbhoiplfn
mailto:https://chrome.google.com/webstore/detail/kgejglhpjiefppelpmljglcjbhoiplfn
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Appendix 

Below is additional information restated from tools/platform perspective developed by the IT 

Accessibility Constituent Group . It is designed by the IT Accessibility Constituent Group  to 

provide guidance to authors, reviewers, and publishers associated with, on how to ensure that 

web content is accessible to all users, including those with disabilities. 

Source page at: https://sites.google.com/a/educause.edu/educause-wiki-site/educause-

accessibility-guidelines 

Documents Accessibility 

Accessible 

Word 

Processing 

Documents 

More information about creating accessible Microsoft Word documents, 

and converting them to HTML, is available in the WebAIM article simply 

titled Microsoft Word. 

Document Structure and Presentation 

• Place content in logical reading order so that the document 

renders correctly when the display size is changed, or when the 

document is magnified or converted into alternative formats 

(audio, HTML, PDF, DAISY, Braille etc.). 

• Avoid complex layout, sidebars, and other ornamentation as they 

make it difficult to maintain a logical reading order. 

• Avoid placing content in drawing-canvases or textboxes as these 

are floating objects and flow to the bottom of a page’s reading-

order 

• Use structural and stylistic features that are built into word 

processing software (e.g., headings, paragraphs, lists, sections, 

headers/footers, tables, columns, forms). This ensures that 

objects on the page are coded semantically, and this information 

is passed on to HTML or PDF files when exported and plays a 

critical role in screen reader users' ability to navigate efficiently 

through these documents.   

Images / Non-Text Objects 

• Always provide an alternative text description ("alt text") for all 

non-text objects (graphs, images, illustrations, multimedia, etc.). 

Users of non-visual devices such as screen readers or Braille 

output devices depend on alt text to access the essential content 

of the images. 

http://www.educause.edu/ITAccessibilityConstituentGroup/13069
http://www.educause.edu/ITAccessibilityConstituentGroup/13069
http://www.educause.edu/ITAccessibilityConstituentGroup/13069
https://sites.google.com/a/educause.edu/educause-wiki-site/educause-accessibility-guidelines
https://sites.google.com/a/educause.edu/educause-wiki-site/educause-accessibility-guidelines
http://www.webaim.org/techniques/word/
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• Most word processing software applications provide a means of 

adding alt text to images, and this is passed on to HTML or PDF 

files when exported. For example, in Microsoft Word 2003, you 

can add alt text to images by right clicking on an image, then 

selecting "Format Picture", then selecting the "Web" tab, then 

entering text into the "Alternative Text" field. In Word 2007, this 

same feature is accessed by right clicking on an image, then 

selecting "Size", then selecting the "Alt Text" tab. 

• If images are provided as separate image files (e.g., JPEG, GIF, 

PNG) an alternative text description must be provided separately 

within the document, clearly identified as alternate text for a 

particular image (e.g., "Alt Text for Figure1.gif").  

• Alt text should communicate the essential content of the image as 

efficiently as possible. 

• Alt text should not be provided for decorative elements. 

• If multiple images are used for a single concept, they should be 

merged into a single composite image. 

• If images communicate highly detailed visual information, as in 

charts or graphs, a long description must be provided in addition 

to the shorter alt text. This should be provided separately within 

the document, clearly identified as a long description for a 

particular image (e.g., "Long Description for Figure1.gif"). See the 

section "Images Requiring Long Description" below for 

information about how this information is utilized in HTML. 

Data Tables 

• When a non-visual user (e.g., screen reader or Braille user) reads 

a data table, the default reading order flows by row from the top 

left cell to the bottom right cell in the matrix. As tables increase in 

complexity (especially if there are nested columns or rows), it 

becomes increasingly challenging for non-visual users to 

understand their position with the structure of the table. HTML 

provides markup that allows table structure to be explicitly 

communicated to non-visual users. Word processing software 

does not have similar markup or functionality. Therefore, the 

process of converting a data table to HTML requires extra steps 

to properly mark it up for accessibility. See the section on Data 
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Tables under Accessible Web Pages for more information about 

accessible table markup in HTML.    

Links 

• Use link text that makes sense out of context. Screen readers are 

equipped with functionality that allows users to pull up a list of 

links on the page and navigate through that list either in order of 

appearance or alphabetically. In this context, links that are 

dependent on context (e.g., redundant links or "click here") make 

no sense. 

• Use link text that is succinct and easy to verbalize. Speech 

recognition users select links by speaking the link text. Long, 

complex link text, including URLs, are difficult to verbalize and 

should therefore be avoided. 

Accessible PDF Portable Document Format (PDF) is a file format developed by Adobe to 

deliver and render on the web, documents created for print. It preserves 

a source document's original style, layout, formatting, fonts, images, etc. 

A PDF document uses a helper agent to “view” or “read” the document 

on the screen making it independent of operating system, authoring 

software and display device.  

General Types of PDF Files 

•  Image: a graphical representation (unstructured) of the original 

document.  They are created by scanning the original document 

as an image and are inaccessible to assistive technologies such 

as screen readers. 

• Searchable Image: (structured) consisting of image + electronic 

text of the original document.  They are created by using 

the Adobe Distiller or other PDF writers. The text is searchable 

and is partially accessible to screen reader, although without the 

markup that is required for full accessibility. 

• Tagged Document:  a true electronic document, with searchable 

text and an underlying semantic structure. This is the only type of 

PDF that has full support for accessibility, including a heading 

structure that can be easily navigated by screen reader users, 

support for alternative text for images, and the ability to reflow 

(wrap) document text when zoomed. Tagged PDF is created by 
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default when converting to PDF from Microsoft Word, Excel, and 

PowerPoint using Adobe's Acrobat PDFMaker plug-in for Office.  

Creating Accessible PDF Files 

•  Craft original document with accessibility in mind (see the earlier 

section on Accessible Word Processing Documents).  Keep in 

mind that: 

• Complex tables may not be correctly interpreted by screen 

readers.  

• Complex layouts with multiple layers may not be fully recognized 

or might follow a reading order that is not consistent with how the 

information is presented visually. 

• The steps for converting a document into an accessible Tagged 

PDFfile depend on the original source of your document:  

• Documents created in Microsoft Office and several Adobe 

products are converted by default to a tagged PDF file when 

exported via the PDF toolbar, the PDF menu, or Save As > PDF. 

For this to result in an accessible document, care must have been 

taken when authoring the document to include semantic structure, 

add alternate text to images, and other accessibility techniques as 

described in the Accessible Word Processing Documents section 

of these guidelines. 

• PDF documents generated using Acrobat Distiller and other PDF 

writers are not tagged by default. However, accessibility can be 

added post-production using Adobe Acrobat. The first step in 

making the document accessible is to select the menu item 

Advanced > Accessibility > "Add Tags to Document". Note that 

this is only the first step. Additional steps must be taken to add 

alternate text to images, add heading structure, check for proper 

read order, etc. Adobe Acrobat provides tools that support these 

steps in the Advanced > Accessibility menu. An audible text 

reader is also available in both Acrobat and Acrobat Reader, 

accessed via the menu by selecting View > "Read Out 

Loud".  Additional information about checking for and fixing 

accessibility in PDF files is available in WebAIM's article 

titled PDF Accessibility. 

• PDF documents created as scanned images require the same 

procedure as in the previous item, plus the additional first step of 

performing optical character recognition. This can be done within 

http://www.webaim.org/techniques/acrobat/
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Adobe Acrobat via the Document > "OCR Text Recognition" 

menu.  

Accessible 

slides 

When presentation slides are delivered over the web, there are two 

general accessibility considerations: The slides must be created with 

attention to accessibility; and the slides must be delivered in a format 

that is perceivable and operable to all users. One good test for 

operability is to try to advance the slides, or operate any other slide 

controls, using keyboard alone. Since the most common slideshow 

application is Microsoft PowerPoint, these guidelines focus primarily on 

PowerPoint accessibility. 

Creating Accessible Slides 

• Use a standard design style template. Templates create 

organized placeholders for standard content. Using them 

increases the likelihood that when content is exported it will be 

properly exposed to conversion tools and assistive technologies. 

• Be attentive to reading order. If text boxes are added to a 

standard slide design, be aware that the content of the text boxes 

will be appended to the end of the read order, which in some 

cases may result in an illogical flow for non-visual users.    

• Add alternative text to all images. The technique for doing so in 

PowerPoint is similar to that of Microsoft Word: In PowerPoint 

2003, you can add alt text to images by right clicking on an image, 

then selecting "Format Picture", then selecting the "Web" tab, 

then entering text into the "Alternative Text" field. In PowerPoint 

2007, this same feature is accessed by right clicking on an image, 

then selecting "Size and Position", then selecting the "Alt Text" 

tab. 

• Use discretion with embedded multimedia, automatic progression, 

transitions, custom animations, and similar features when 

PowerPoint presentations are intended for distribution over the 

web. If the PowerPoint will be distributed in its original format, 

some of these features may inherently pose accessibility 

challenges. If the PowerPoint will be exported to HTML or PDF, 

these features may not survive the export, and the remaining 

content may be impacted by their absence.  
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• Provide sufficient contrast between foreground and background 

colors, and avoid using patterned backgrounds 

• Give each slide a unique title, since this information can help to 

facilitate navigation, both within PowerPoint and within exported 

formats.   

• If inserting diagrams, charts, or tables into a PowerPoint slide, 

consider accessibility best practices. Techniques vary depending 

on how the slides will ultimately be delivered. Microsoft provides 

additional details related to specific PowerPoint features in their 

document Creating accessible PowerPoint presentations.  

 Distributing Slides Over the Web 

• If PowerPoint slides are distributed in their native format, users 

must have PowerPoint or an alternative software package that is 

capable of reading PowerPoint. A free PowerPoint Viewer 

browser plug-in is available from Microsoft, but it does not work in 

all browsers nor across all operating systems and does not work 

well with assistive technologies.  

• PowerPoint has built-in features for saving to web pages, but the 

output is a complex frameset with pages that are coded in ways 

that are not well-supported by assistive technologies. 

• PowerPoint can be converted to valid, accessible HTML with 

software such as Virtual 508.com Accessible Web Publishing 

Wizard for Microsoft Office. In addition to exporting to an 

accessible format, both products provide a wizard interface that 

helps to identify accessibility problems and solutions.  

• PowerPoint slideshows can be exported to PDF using Adobe's 

Acrobat PDFMaker plug-in for Microsoft Office, accessed via the 

PDF toolbar, the PDF menu, or Save As > PDF. As with Microsoft 

Word, this plug-in exports by default to a tagged PDF file. 

However, for this to result in an accessible document, care must 

have been taken when authoring the document to use standard 

design templates, add alternate text to images, and other 

accessibility techniques as described in the preceding section. 

The resulting output is a single file and is therefore easily 

distributable. 

 

http://office.microsoft.com/en-us/powerpoint-help/creating-accessible-powerpoint-presentations-HA102013555.aspx
http://www.virtual508.com/
http://www.virtual508.com/
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Accessible Web Pages 

Document 

Structure and 

Presentation 

HTML is a semantic, structured language. Assistive technologies such 

as screen readers utilize this structure extensively, so it is critical that 

HTML be used properly to support accessibility.  

• HTML heading elements must be used to markup all headings 

and subheadings. If used properly, the headings on a page form 

an outline of the content of that page. 

• HTML list elements must be used to markup any lists of content, 

including navigation menus (which are lists of links). 

• Forms must include markup that explicitly communicates the 

structure of the form, and the relationships between its parts. The 

most fundamental step in creating accessible forms is to use the 

HTML label element to identify labels and explicitly associate 

them with the form fields they represent. Additional information 

about accessible forms in HTML is available in the WebAIM 

article Creating Accessible Forms. 

• HTML should be validated using the W3C Markup Validation 

Service. This increases the likelihood of interoperability across 

platforms and browsers. 

Images /Non-

text Objects 

Images must have alternate text in order to be accessible to non-visual 

users. The method for providing alternate text varies depending on the 

content of the image, and the method of submission:   

• In HTML, the <img> element must have an alt attribute, e.g., 

alt="description of the image" 

• If the image is decorative, the best practice is to deliver the image 

as a background image using Cascading Style Sheets. However, 

if an HTML <img> element is used, include a NULL alt attribute 

(alt=""). This is a standard practice that instructs screen readers 

to ignore the image. 

• Alt text should communicate the essential content of the image as 

efficiently as possible. 

• If images contain text, repeat the text verbatim. 

http://www.webaim.org/techniques/forms/
http://validator.w3.org/
http://validator.w3.org/
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• If images contain highly detailed information, as in charts or 

graphs, provide a succinct alt attribute (e.g., alt="Figure 1"), and 

provide additional detail using a long description (see below).  

Images 

Requiring Long 

Description 

If images communicate highly detailed information, as in charts or 

graphs, the important content from these images must be communicated 

in a long description. 

• The long description should be provided in a separate HTML 

page. 

• The <img> element should have a longdesc attribute, which 

points to the URL of the separate web page where the long 

description is available (e.g., <img src="figure1.gif" 

longdesc="figure1_description.html"/>). 

When screen reader users encounter an image with a long description, 

they are informed that the image has a long description, at which point 

they have the option of reading that description or skipping it.  

Data Tables The following HTML markup is needed in order to ensure that non-

visuals users can navigate tables with full awareness of their position 

within the table, and of how all parts of the table are related. 

• Wherever possible, avoid complex tables with nested rows and 

columns or split or merged cells. Even with accessible markup, 

complex tables present usability challenges for non-visual users, 

and they are not easily converted into alternative formats such as 

Braille. 

• Include a summary attribute with the table element (e.g., <table 

summary="This table shows...">). The summary attribute is read 

by screen readers, but is not displayed visually. The purpose is to 

provide a succinct overview of the table's content and layout so 

screen reader users can explore the table with an idea of what to 

expect. 

• Markup the table's caption using the HTML <caption> element. 

This ensures that the caption is explicitly associated with the 

table, for non-visual users. 
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• Markup column and row headings with the HTML <th> element, 

and include a scope attribute to identify whether the heading is for 

a column (<th scope="col">) or row (<th scope="row") 

For complex tables, include id attributes on all <th> elements, and 

headers attributes on all <td> elements, where the value of the headers 

attribute is a space-delimited list of id's that correspond with the current 

table cell. 

Links • See the corresponding section above, under Accessible Word 

Processing Documents. 

• Avoiding causing links to open in a new window. This can be 

disorienting to users of assistive technologies and is unreliable 

given the widespread use of pop-up blockers. 

General 

Considerations 

• Be sure that all links, form fields, and controls can receive focus 

and be operated without a mouse. This can be tested by 

navigating through a web page using the Tab key in most 

browsers.   

• Avoid using color as the sole means of communicating 

differences or other information. Keep in mind that some users, 

including those who are blind or color blind, are unable to 

perceive differences between color. 

• Avoid causing objects on the screen to flash (i.e., in a strobe-like 

effect). Flashing objects can trigger seizures in susceptible 

individuals.   

• Avoid using or requiring plug-ins or other technologies that do not 

honor the user's operating system or browser settings for font 

choice, font size, and alternative color scheme. This can be tested 

by changing these settings within the preferences of the browser 

or control panel of the operating system, then refresh the web 

page to determine whether it is still usable.    
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Accessible Online Applications 

 

Accessible On-

line 

Applications 

On-line applications such as interactive games, automated simulations, 

etc., are each unique, and therefore must be evaluated individually for 

accessibility. The following is a quick checklist of some of the issues to 

consider:  

• Can the application be operated without a mouse, e.g., using 

keyboard alone or speech recognition technology?  

• Is the application accessible to blind individuals using screen 

readers or Braille output devices? 

• Does the application avoid using color as the sole means of 

communicating differences or other information? 

• If the application includes audio or video, are these features 

accessible as defined in the preceding two sections? 

• Does the application avoid causing objects on the screen to flash 

in a way that may trigger seizures in susceptible individuals?  

• Does the application honor the user's operating system or 

browser settings for font size or alternative color scheme? 

• If the application changes automatically over time, does it provide 

a mechanism by which the user can pause or override this 

behavior? 

 

 

E-mail Accessibility 

General Tips 

 

• Use an indicative and catchy subject line 

• Use sufficient font size and color contrast 

• Do not use color alone to convey information 

• Simplify the language and ensure it is appropriate to the audience 

• Describe links and images sufficiently for screen readers 

• Use an accessibility checker to test your e-mail accessibility 

Source: https://www.abilitynet.org.uk/news-blogs/creating-accessible-emails 

Text • Use at least 12 pt. font size 

https://www.abilitynet.org.uk/news-blogs/creating-accessible-emails
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• Avoid blinking text (not more than 3 times per second) 

• Avoid using ALL CAPS unless the word is an acronym  

• Use no more than three different fonts 

Colors • Use sufficient color contrast for backgrounds and text.  Some 

colors might look nice but do not work in terms of readability for 

visually impaired users 

Images • When you add an image in an email, provide “alternative text” to 

the image to convey content. Also, avoid using images of text. 

• Mark images with no content as “decorative” 

Headings • Use Headers. If you use headers screen reader users are able to 

work out the hierarchy of the page. 

Links • Use meaningful link text. If you label a hyperlink with "click here" it 

does not really help anyone let along people with cognitive or 

visual impairments. 

• Provide complete URLs. 

• Provide useful information about the hyperlink in text to display 

Lists and 

Columns 

• Use the Bulleted and Numbered lists to organize paragraph data. 

Tables • Use tables to present tabular data but keep them simple with 

clear headers. Mark the table headers and first column for screen 

readers. 

Check / Test 

Accessibility 

• Outlook Accessibility Checker under the message “Review” 

ribbon (a feature in Outlook for Office 365, Outlook 2016 and 

2019) 

• Accessible Email (HTML) 

http://www.accessible-email.org/ 

Detailed 

Checklist 

• https://www.hhs.gov/web/section-508/making-files-

accessible/checklist/email-508-checklist/index.html 

 

http://www.accessible-email.org/
https://www.hhs.gov/web/section-508/making-files-accessible/checklist/email-508-checklist/index.html
https://www.hhs.gov/web/section-508/making-files-accessible/checklist/email-508-checklist/index.html

